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For changing settings, downloading and analyzing data
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SYNOLOG-TDx/TD1x/HDx/HD2x FEATURES

Easy to Read Display

High Accuracy, +/-0.5°C

Precise, 0.0625°C resolution

Internal Temperature Sensor

Internal Accurate Humidity Sensor (for HDx and HD2x)
External Temperature Probe (optional for TDx and HDx)

User Preset Visual and Audible Alarms on External probe (with snooze mode)
High Alarm LED

Low Alarm LED

Large Logging Memory

Easy to Use Free Software

Long battery life

Memory Lasts over 100 years without power

Memory can be filled over 50,000 times

Battery Powered

Tough Casing

Environment Resistant

Digital temperature sensor interface reduces interference and improves
accuracy, no calibration required.

Download data to PC easily and quickly

Can update unit when new attachment products are released.




SYNOLOG- TDx/TD1x/HDx/HD2x FUNCTIONS

e Display Ambient Temperature
e Display External Probe Temperature (With External Probe with SynoLog-TDx
and SynoLog-HDx)

O
O
O

Display Humidity (Synolog-HDx & SynoLog-HD2x models)
Display Time

Record Over 16,000 Data Points

High and Low Alarms on Ambient or External Probe Temperature

Audible (With Snooze)
Visual Indicators
Change Alarms

Scheduled Log
Enable/Disable Logging

SYNOLOG STUDIO FUNCTIONS

e Download Data from Synolog-TDx/TD1x/HDx/HD2x

O
O

Either erase or leave memory after download
Automatically graphs after download

¢ Change settings in Synolog-TDx/TD1x/HDx/TD2x

O

O O O O O O O

(@]

e Graph data

(@]

O O O O O

Celsius or Fahrenheit

High alarm temperature and enable/disable

Low alarm temperature and enable/disable

Data Save Interval

Snooze Time

Time

Date

Enable/Disable Logging

Change Scheduled Log Settings or enable/disable either

Automatically adjusts temperature scale to suit data
Zoom into particular data section

Enable/Disable Data sets including High/Low alarms
Print graph

Celsius or Fahrenheit

Open previous temperature files

e Table of data

O

Easily Identify Data Points Above or Below Pre-set Alarm
Temperatures

Save Data in Microsoft Excel Compatible Format
Show Current Temperature/Humidity

Show Serial Number and Product Mode

Erase Memory

Change Communication Port Settings
Integrated Help




SYNOLOG STUDIO REQUIREMENTS

Features

Easy To Use
Change Synolog Settings
Download Data From Synolog
Analyze Data in Graph/Table
All Functions on Main Screen

Windows Operating System

Win 98, Win ME, Win2000, Win XP

Minimum CPU Requirements

Pentium, 1 Ghz

Minimum Hard Disk

10 MB

Interface Standard

RS-232 Serial or USB

Hardware Required

Spare 9 Pin RS-232 Port or Spare USB Port

INSTALLING THE SYNOUSB USB DOWNLOAD CABLE
(Skip this step if you have a Syno232 cable)

1. This step installs the SynoUSB cable on your computer, it creates a Virtual
COM port which can be selected in SynoLog Studio once installed.

2. Plug in the USB cable into a free port and Windows will detect the USB
Device and run the new hardware wizard to assist you in setting up the
new USB Composite Device

3. Place the provided CD in the PC CD Drive and click next to continue

a. Select Search for the best driver for your device and click next

b. Select Specify a location and click Browse. Change the folder to
your CD drive (ie: D:\ ) and click OK.

c. Double check the directory that windows prompts. Click Next.
d. Windows will detect the driver (USB2SER.inf) and shows the USB to
Serial Cable. Click Next to continue until the installation is

complete.

e. Click next to continue and let windows copy the needed files to
your hard disk. Click Finish while installation is complete.

f. After installing, the System will generate an additional COM Port,
USN to Serial Port (COM3) for the connection to the SynolLog Unit.




4. To check the COM port which has been selected, please follow the
following instructions.

a. In the start menu, click on Control Panel

b. In Control Panel, select the System category.
c. Click on the Hardware TAB in the System menu
d. Click the Device manager button

e. You will be able to see the the COMM port under the Ports (COM &
LPT) item as Prolific USB-to-Serial Comm Port (COM3).
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f. The COM port differs depending on your computer and can be
changed by double clicking on this item, selecting the Port Settings
Tab and clicking on Advanced. The COM port can be changed here
if required.

5. Please note that when the USB cable is plugged into different USB ports
and hubs the Virtual COM port number can change and needs to
reselected.




LOADING SYNOLOG STUDIO SOFTWARE

1. Place provided CD in Drive, choose run from the start menu, select the
appropriate CD drive and the file Synotronics Data Logger.msi. OR please
check the Synotronics website for the latest version
http://www.synotronics.com.au/download.htm

2. Click OK to continue installation

i Synotronics Data Logger

Welcome to the Synotronics Data Logger
Setup Wizard

The installer will guide you through the steps required to install Synotronics D ata Logger on your
computer.

Click "Mext" to-continue,

WARNING: This:computer program iz protected by copyright law and intemational reaties.
Unauthonized duplication or distribution of this program, or any portion of it, may result in severe
civil or criminal penaltiez, and will be prozecuted to the maximumm extent possible under the law.

3. Read the End-User Agreement and click on the "I Agree” button, then click
next.

|§ Synotronics Data Lopger

License Agreement SYNOTRONICS
IN\!INT_IHG FOR LW[
Please take a moment ta read the license agreement now, IF pou accent the terms below, elick |
Agree’’, then "Mest'’. Othenvize click "Cancel;
End-User Agreement -
Software Products: Synolog Studio and
accompanying documentation ("Freeware").
Licensor: Synotronics Pty Ltd
THIS IS A LEGAL AGREEMENT BETWEEN YOU, AN
END USER, AND LICENSOR.
e e e - o s,
)1 Do Mot Agree (}_?_)
| LCancel l | Frevious ] ’ Mest ]

4. If the Synotronics Data Logger directory is suitable to have on your hard
drive then click Continue, otherwise change the directory and click
Continue.




i Synotronics Data Logger

Select Installation Folder SYNOTRONICS

WVENTING FOR LIFE

The ingtaller will ingtall Spnotionics Data Logger in the following falder,

Tovinstall in this folder, click "Nest”. Ta install ta a different new or existing folder, enter one
below aor click "Browse",

Folder: }C: “Program FileshSpnotromics 0ata Loggerh Browse...

You can install thie software on the following drives:

Walume: Dizk Sizr

== 1 BEGE

£ | >
Caticel ] [ Previous ] [ MHext J

5. Click next to continue.

i Synotronics Data | ogger

Confirm Installation SYNOTRONICS

WVENTING FOR LIFE

The inztaller iz ready to install Synotronics Data Logger oh your computer.

Click "Mext" tostart the inztallation,

Cancel Il Ereviousz Il_ Mest i

6. The following box will then be displayed showing the loading of the
software.




i Synotronics Data Logger

Installing Synotronics Data Logger

Synotionics Data Logger iz being installed,

| Cancel Privinl K

7. The following box will then be displayed indicating a successful loading of
the software. The program should now be in your start menu and ready to

go.

i Synotronics Data Logper

Installation Complete SYNOTRONICS

INVENTING FOR LIFE

Synotronics Data Logger has been sucessfully installed,

Click "Cloze' to exit,




CONNECTING SYNOLOG- TDx/TD1x/HDx/HD2x TO PERSONAL COMPUTER

1. Plug the Syno232 RS-232 9 Pin D connector into a spare RS-232 slot on
the PC or the SynoUSB cable into the spare USB Port.

2. Plug the other end of the cable into the Synolog-TD/HD connector on the
base of the unit.

3. Open Synolog Studio

4. Select the appropriate RS-232 Comm Port in the Settings->Comm Port
Menu

=% Synolog Studio
File

Qptions About

(v comn 118
M Commr2 I
Comm 2

IE _:_r_' Carr 4

Commi 5

Comm @
Comm 7
Comm 8
Comm 9
Comrr 18
Comm 11
Camm 12

Comini 13

5. The Log Options should now become enabled, if not press the down button
on the Synolog-TDx/TD1x/HDx/HD2x, this should establish the connection
between the unit and the software.

6. You can now change settings and download data etc whilst this is
connected. (For longer lasting battery power it is recommended not to
leave the Synolog-TDx/TD1x/HDx/TD2x plugged into the Syno232 cable
when not required)




CHANGING THE CONNECTION SPEED TO THE SYNOLOG

The connection speed from the PC can be changed between slow and fast. If you
have problems downloading, it is recommended to use the slow speed otherwise
the fast speed is the best option.

To change the setting, first connect the SynolLog to the PC as per previous
instructions. Once connected select in the top menu, Settings->Connection
Speed and then Slow or Fast.

= Synotronics Data Logger Analyser - C:\Documents

v3 Show Probe

Temperatire ‘ ‘ _—|-

The setting will then change in the SynoLog which will be detected by the
SynolLog Studio software

RESETTING THE CONNECTION SPEED MANUALLY

If you have set the SynoLog unit for Fast connection speed and your computer
can not connect to the SynolLog unit you can reset the speed to slow. This is
done by pressing on the Synolog unit the ‘up button’, holding it and pressing the
‘down button’ until the screen goes blank briefly and release the buttons.




CHANGING SYNOLOG SETTINGS - USING SYNOLOG STUDIO

Follow the previous instructions to connect the Synolog-TDx/TD1x/HDx/HD2x unit
to the PC, changing settings using the Synolog Studio can only be achieved whilst

connected.

It is recommended to connect the Synolog unit to the PC after a

battery change to alter settings including the time.

Changing Log Options

Once connected, settings can be change in the
Synolog-TD/HD in the following menu screen. Options
can be changed by using the scroll bars next to or
below the settings. Selecting a check box allows the

relevant setting to be enabled.

Changing Scheduler Options

Log Options | Cumrent Temp

Celsiuz OR & =
Farenheit ! —i
High Alarm W Tﬁﬁj
Lowalam [ —i j
Alamon ~ Alamon ~
Ambient Frobe

[ata Save _i
Interval [Minutes)

_.l
Snooze Time [Hrs] 4 j

| 14 ¢

Sy

Time ki

Date |

o |
D a_l,l Manth _?Ear

Logging Data Mow v

These functions allow you to schedule a logging period for a future time period.

Change Start of Schedule

|

Log Schedule

Start End
Scheduled Start [
Eraze At Start [w
Tirme ED: ES

] ol

Hour  Minute

Date |_3 [ 1|07
A [ e B |

Da_l,l Marth Fear

Rezet Start Time ‘

Functions

Scheduled Start — Check if you want a
scheduled start.

Erase at start — Check if you want the
data to be deleted when a scheduled
log begins.

Time & Date — Change this using the
scroll buttons to be the time you wish
the logging to start.

Reset Start Time Button - This resets

the start time to the current time in the

logger.

Change End of Schedule

T

Stark

Log Schedule ]
End

Scheduled End B

Time

: |_EE
A i |

[17
s |
Hour  kinute

Diate | g | | 07
i | _._L..J Al
Dray Month Year

Rezet End Time

Scheduled End - Check if you want a
scheduled end of logging.

Time & Date — Change this using the
scroll buttons to be the time you wish
the logging to end.

Reset End Time Button - This resets
the end time to the current scheduled
start time in the logger.
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CHANGING SYNOLOG SETTINGS - USING SYNOLOG
The following settings can be changed using the buttons of the Synolog

1. High Alarm (indicated by the High Alarm LED being turned on)

2. Low Alarm (indicated by the High Alarm LED being turned on)

3. Recording Data on/off (indicated by RECO(recording off) or REC1(recording
on) on the Synolog screen)

This is achieved by holding the down button for at least a second; it will beep
when the new settings mode has been entered. The order it follows is as above.
Once the new settings mode is entered, the setting can be changed by pressing
the up or down buttons. To leave the change settings mode the button can be
held again for a second or left for it to automatically change back to the
temperature mode.

Temperature/humidity and
settings display screen

High alarm
indicator - Red

Low alarm

indicator - Green Up button

Airflow to Down Buttaon

ambient sensor

External probe/Syno232 connector
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DOWNLOADING DATA FROM SYNOLOG-TDx/TD1x/HDx/HD2x

To download data from the Synolog-TDx/TD1x/HDx/HD2x you must first connect
it to the PC via the Syno232 and start the Synolog Studio software.

1. Once connected to the device click on the Download Data Menu Item

ynotronics Data | opger Analyser -

e Optons Settings EEGIEREREE Abo

Log Options | Curent Temp

Celziuz OR 1|: ,1

Farenheit

High&lam W <[450 2

2. If you want to delete the memory of the logger after the data has
downloaded click yes, otherwise click no to record at the end of the
current data.

Synotronics Data Loager

Do you want to delete the loggers memory after download?

Yes Mo

3. Select a filename and click save

Save jn; ]4- [e8] __'__] = c5 EH-

A, [ 5ynatronics

£

My Recent
Documents

&ﬁ

File narne; itest :j Save |
_:j Cancel

by Metwork,  Save as byps: ]Synolrc-niw Data Files [*.39m)
Places
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4. The screen will then show that the data is downloading and the Synolog-
TDx/TD1x/HDx/HD2x screen will show the percentage of data remaining to
download.

2% Synolog Studio.
File Options ~Settings About

i

i

Currently Downloading ..

ﬁ;ﬂﬂ

e Ll

£

L“ E
] 1k
= | e Eh

s
L
£
=

i

5. Once downloaded the data will be saved and graphed automatically.

Temperature (C)/Humidity (%) Vs Time Graph 1 File Data

B
C L] Temperature { Humidity vs Time —— Ambisnt Temperature

—— Ambient Humidity
—— High Alarm

— LowAlarm

— 28DF496D000000E9

El =

Temperature (°C) / Hurmidity (%RH)

20
T
L

TS AN S M A SR RO e N O S OO O R N O
0218 15:20 04:22 17:24 06:28
11Dec 08 12 Dec 08 14 Dec 06 15Decdf 17 Dec 06
Time & Date

i — Ty

EXPORTING DATA TO EXCEL

The data is saved in a file with extension *.syn. This can be exported easily
into Microsoft Excel by opening it as a tab delimited file

Select Open in Excel

In the Files of type, select “All Files”

Select the file you would like to open

The text import wizard will open

Click next to open as a delimited file

In the next screen select ‘Tab’ in the Delimiters menu and click *next’

oOUuhwWNE
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In the next screen click finish

The data will now be in Excel. If you save this file in Excel you will not be
able to open it again in SynolLog Studio so it is recommended to save as a
different file in Excel.

@ N

VIEWING DATA

To view the data downloaded or recovered from a saved file click on the “File
Data” Tab near the top right. This will allow you to view each data value.

If the data value has gone above or below preset limits this will be shown by
making the data red (above preset high limit) or blue (below preset low limit).

=% Synotronics Data Logger Analyser - C:\Test -syn
File Options ‘Settings Liovilcad Da

Graph T Scheduler Temperature [C)Humidity (2] %= Time Graph T iFile Dalaj
Show Probe — Date Time Probe Name Probe Ambient Ambient Dycet Preset B
Tsmperaliis (ddmmivy) | (hhmm) Temperature | Temperature | Humidity (%) (T ow Alm
S €0 cQ) (C)
e el — 31-10-05 1552 28B5136D000000CD 332500  27.5000 -31.000
Gigee 31-10-05 1354 | 28B5136D00000OCD 335000  27.7500 -3L.000
High &lam 31-10-05 1556 28BS136D000000OCD 338125  28.0000 -31.000
e 31-10-05 1538 |28B5136D000000CD |34.0625 282500 |-31.000
31-10-05 1600 | 28B3136D000000CD 343125 285000 | |-3L.000 3
[E =] GrophaiTine 31-10-05 1602 28B5136D000000CD 34.5000  28.7300 -31.000
__| | [31-10.05 1604  28B5136D00000OCD 3 29.0000 -31.000
(Lou Options | Cuet Tona | 31-10-05 1606  28BS136D000000CD 291875 |-3L000
= 31-10-05 1608 |28B5136D000000CD 294375 31.000 |3
I g5 31-10.05 11610 |28B5136D000000CD | 296250 ' |-3L000 |
31-10-05 1612 | 28BS136D000000CD 29.8750 -31.000
r ang 31-10-05 1614 | 28B35136D000000CD 30.0000 ~31.000
4 31-10-05 1616 | 28B3136D000000CD 300000 |-31000 3
31-10.05 1618 28B5136D000000CD 33.5625  20.8750 ~31.000
4 31-10-05 1620 |28B5136D00000OCD |32.93 28.7500 1-31.000
i 31-10-05 1622 |28B5136D000000CD 20,5625 -31.000
s 31-10-05 (1624 | 28B3136D000000CD | 293125 | |-3L.000 |
T D 31-10-05 1626  28B5136D000000CD 3 291250 |-31.000
wliM i 31-10-05 1628 | 28B5136D000000CD 28.8750 ~31.000
[ 31-10-05 1630  28B3136D000000CD 28,6875 |-31.000
_ 31-10-05 1632 28B3136D000000CD | 285000 | |-3L000 |34
i 31-10-05 1634 | 28B5136D00000OCD 283750 ~31.000
i 31-10-05 1636 | 28BS136D000000CD 3 28.2300 |-31.000
31-10-05 1638 | 28B5136D000000CD 28.187% ~31.000

-14 -



ASSIGNING & CHANGING PROBE NAMES

Each probe has a distinct serial number, when the data is downloaded these serial
numbers are downloaded also. The serial numbers can be given a hame to make
it easier for the user to know which is which.

To assign or change a name, double click on the serial number you wish to
change. A change probe name dialog box appears.

Graph T Scheduler ] | Temperature [C)/Hurmidity [%] %z Time Graph

Probe Wame

v

¥ Tem Serial Mumb

o Shonp SRS | 2885130000000 | <551 36D000000CD

— She Mhmeil ot I 2EBA136D000000CTD |
High 2EBA136D000000CD
Sha 18B513 '

I s | Change MName | Cancel Change ::E:ijgggggggggg

C :I' T | T LoD T28BA136D00000OCD |

: - 31-10-05 1604 | 28B5136D000000CD
T— 31-10-05 1606  28B5136D00000OCD |
[—_| 31-10-05 |16:08  28B5136D000D0O0OOCD
i 6T 31-10-05 |16:10 | 28B5136D000000CD |

31-10-05 |16:11  IEB5136D000000CD |

B -1 - 21 10 nE 1£-14 TOD &1 2 AT T

Ll

In the Name/Location text box type the new name for the probe and click the
change name button.

? Temperature [C)Hurmidity [%] Wz Time Graph T-
- Date Time Probe Name Probe
(dd'mm/yy) |(hhmm) Temperatu
B (°C)
- 30-10-05 |213:55 | New Probe Name 24 9375
30-10-05 |23:57 | New Probe Name 308750
B 30-10-05 23:29 New Probe Name 287500
— 31-10-05 001 INew Probe Name 27.8750
31-10-05 |0:03 New Probe Name 263125
J 31-10-05 |0:05 New Probe Name 254375
— 31-10-05 | 0:07 New Probe Name 250000
— 31-10-05 009 INew Probe Name 24.6250
| 31-10-05 |0:11 New Probe Name 24 3750
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OPENING SYNOLOG FILES

Downloaded files are saved with the extension *.syn. In order to open previously
saved files click on the File Menu Item and then Open, this will open a dialog box
to find the file where you saved it. This will then be opened in the graph and the
table.

=% Synotronics Data Logger A
File

Open Ctri+0

Print Cirl4P

PRINTING THE GRAPH

Click on the File Menu Item and then Print.

=
=

I Synotronics Data Logger A
3-8 Ciptions Settings
Open Cirl+0

Select Print Graph and click Print. This will print whatever you had selected on
the graph.

* Print Graph
" Print Table
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A Print Preview screen will appear showing what will be printed. Click Print to
print the graph.

EZ Print Preview - C:\Documents and Settings\Tyson\My Documents\test 8-1-07.syn

Print (Close Print Preview

Temperature [ Humidity vs Time —— Ambient Temperature
T T T T T T T T T T T T T T T T —— Ambient Humidity
— High Alarm
o —— Law Alarm
—— 2B8DF495D000000ES

Temperature ("¢ Humidity (R RH)

. | L | I | . | I | I . | | 1 1
Z2:04 00:38 0312 0546 0§20

11 Dec0f 13 Dec 04 14 Dec 06 15 Dec 08 16 Dec 08
Time & Date

PRINTING TABULAR DATA

Click on the File Menu Item and then Print.

=7 Synotronics Data Logger A

3-8 Ciptions Settings
Cpen Cirl+d

Print Ciri+P [

Exit

Select Print Table.

To print all the data, click Print All and then click the Print button.

-17-



Print Select

" Print Graph

- Table Selection

@ Printall " Print Selection

Print. Cancel ]

To print a selection of data, select Print Selection.

& Print Tahle

~ Table Selection 1

7 Print&ll % Print Selection

Start Diate Start Time
I |

Earlizzt Start Time I

Left elick on the graph to input
ztart time:

Feszet Start & End Tme I

Cancel j

Click on the graph on the main screen to select your start time or click the
earliest start time button to automatically insert the earliest start time.

-18 -



e —
" Print Graph
" Print Table

i Table Selaction

© Printal &

End Date End Tinie
| |

Latest End Time \

Left click an the graph to input
and time

Reset Start & End Trme \

LCancel \

Click on the graph on the main screen to select your end time or click the latest
end time button to automatically insert the latest end time.

" Print Graph
* Frint Table

i~ Table Selection

O PrinkAl &

Left click an the graph tainput
ehd hirne

Reset Start & End Tre ]

Frint LCancel ]

The Reset Start & End Time button can be clicked at any time to start the
selection process again.

Click Print to print the data.

=19 -



EXITING SYNOLOG STUDIO

Click on the File Menu Item and then Exit menu item. This will close Synolog
Studio.

synotronics Data Logger A

Cpen Cirl+0
Print Ciri+P

DELETING SYNOLOG MEMORY

Click on the Options Menu Item and then click on Delete Logger Menu. You will

be asked for a confirmation to continue. The Synolog unit will beep when the
memory has been deleted.

=% Synotronics Data Lopger Anal

#al Settinos  Download Dat

Delete Logger Memary g

[ug Uphions | Lurrent Tem

] P e e —— | I




ZOOMING GRAPH

The graph can be zoomed by clicking and holding the mouse button whilst on the
graph and moving while a selection box shows your selection. Release the mouse

button to let the graph zoom.

Temperature [C}/Humidity [%] ¥z Time Graph

|

Filz Data

C =

Temperature [ Humidity vs Time

Ambient Temperature
Ambient Humidity
High &larm

Low Alarm
28DF495D000000ES

Temperature (") Humidity (%REH)

o
) o -
L 1 1 1 | I 1 1 1 | 1 1 1 1 | 1 1 1 1 | 1 1 1 I
2203 12:29 0255 172 07:48
10 Dec 08 12 Dec 06 14 Dec 06 15 Dec 06 17 Dec 05
Time & Date

| | <l

[

o

To zoom out simply right click on the graph, the time it takes to return to the
whole graph will depend on the size of the file.
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CONNECTING & DISCONNECTING AN EXTERNAL PROBE

The connection point for an external probe is on the bottom of the unit, this
connector is protected by a dust cap which needs to be taken off before plugging
in a probe.

The probe connector is then pushed onto the base of the unit, the unit will detect
the probe and the screen display will show the probes temperature after
detection.

The connector has a locking mechanism which requires the top of the connector
to be pulled down to release the lock and thus release the connector.

Temperature /humidity and
settings display screen

High alarm
indicator - Red

Low alarm

indicator - Green Up button

Airflow to Down Button

ambient sensor

External probe/Syno232 connector

Polarized interface




SNOOZE FUNCTION

The user can set high and low alarms; a snooze time can also be set in the
Synolog Studio Software. When the alarms go off the user has the option to
press both the buttons on the Synolog Unit, this will snooze the audible alarm for
the time period set with the Synolog Studio Software.

ADDITIONAL SOFTWARE HELP

For help on the use of each function just hold the mouse curser over each setting
to enable a pop up help box.

I |

Log Dptions | Curent Temp
Celsiuz OR i R |

Farenheit

Selects whether Celcius or Farenheit will be shown on the urniits screen

Lowdlam [ =535 <

[ata Save - :
Interval IMinutes] ,|2 'le

BATTERY SOURCE

The Synolog-TD/HD runs from 3 AAA batteries, these are placed in the battery
compartment on the back of the unit.
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SYNOLOG-TDx SPECIFICATIONS
2 Channel temperature logger with display and external probe connector

General Specifications

Dimensions

28mm x 66mm x 92mm (1.1” x 2.6” x 3.65")

Power Source

3 x AAA, 1 Year Battery Life Replaceable

Operating Range

00C - 859C & 0-100%RH  (-30°C - 65°C with AAA Lithium)

Download Cable

Syno232 Download Cable

PC Software

Designed to use with SynolLog Studio for downloading and analyzing
data.

In-Built Display

Size

46mm x 20mm (1.8” x 0.8")

Resolution

0.1 0C (0°C -85¢°C), 0.1°F

Update Interval

15 Seconds (7.5 sec for half an hour after a probe is connected)

Internal Temperature Sensor (in SynoLog unit)

Type of Sensor

Band-gap with digital interface

Accuracy

+£0.50°C (0 °C - 70 °C), £0.9 OF Related to temperature of internal sensor

Resolution

0.0625 °C (0.1125 °F)

External Temperature Probe

Connector

SynolLog-TDR (Rear connector)
SynolLog-TDB (Bottom connector)

Type of Probe

SynoProbe Digital Interface Probe

Measurement Range

-40 °C - 130 °C (-40 °F - 266 °F)

Serial Numbers

Each probe has an unique internal serial number which is detected
and recorded by the SynolLog

More Details

Come in a range of lengths and in custom size: www.synotronics.com

Temperature Alarms

Visual Alarms

High and low set points trigger separate LED's

Audible Alarms

High and low set points trigger buzzer

Snooze Function

Buzzer can be snoozed for a preset amount of time after trigger

Memory

Recording Sampling Rate

0 - 800 minute Interval (1 minute steps)

Memory Type

Non-Volatile Eeprom

Data Sample Capacity

> 16,000 Samples

Data Retention

> 100 Years Without Power

Other Specifications

Scheduled Record

Unit can be set to start recording at a pre specified start time and
stop at a pre specified end time

EMC

0 EMC Compliant : N15320

Disclaimer: The above specifications may be subject to change without notice. The
manufacturer and its suppliers hold no responsibility for damage expenses, lost profits, or
any other claims arising from the use of these products.
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SYNOLOG-TD1x SPECIFICATIONS
1 Channel temperature logger with display

General Specifications

Dimensions

28mm x 66mm x 92mm (1.1” x 2.6” x 3.65")

Power Source

3 x AAA, 1 Year Battery Life Replaceable

Operating Range

00C - 859C & 0-100%RH  (-30°C - 65°C with AAA Lithium)

Download Cable

Syno232 Download Cable

PC Software

Designed to use with SynolLog Studio for downloading and analyzing
data.

In-Built Display

Size

46mm x 20mm (1.8” x 0.8")

Resolution

0.1 0C (0°C -85¢°C), 0.1°F

Update Interval

15 Seconds (7.5 sec for half an hour after a probe is connected)

Internal Temperature Sensor (in SynoLog unit)

Type of Sensor

Band-gap with digital interface

Accuracy

+£0.50°C (0 °C - 70 °C), £0.9 OF Related to temperature of internal sensor

Resolution

0.0625 °C (0.1125 °F)

Temperature Alarms

Visual Alarms

High and low set points trigger separate LED’s

Audible Alarms

High and low set points trigger buzzer

Snooze Function

Buzzer can be snoozed for a preset amount of time after trigger

Memory

Recording Sampling Rate

0 - 800 minute Interval (1 minute steps)

Memory Type

Non-Volatile Eeprom

Data Sample Capacity

> 16,000 Samples

Data Retention

> 100 Years Without Power

Other Specifications

Scheduled Record

Unit can be set to start recording at a pre specified start time and
stop at a pre specified end time

EMC

0 EMC Compliant : N15320

Disclaimer: The above specifications may be subject to change without notice. The
manufacturer and its suppliers hold no responsibility for damage expenses, lost profits, or
any other claims arising from the use of these products.




SYNOLOG-HDx SPECIFICATIONS
3 Channel temperature and humidity logger with display and external probe connection

General Specifications

Dimensions

28mm x 66mm x 92mm  (1.1” x 2.6” x 3.65")

Power Source

3 x AAA, 1 Year Battery Life Replaceable

Operating Range

00C - 859C & 0-100%RH  (-30°C - 85°C with AAA Lithium)

Download Cable

Syno232 Download Cable

PC Software

Designed to use with SynoLog Studio for downloading and analyzing
data.

Display
Size 46mm x 20mm (1.8” x 0.8")
Resolution 0.1°C (0°C -8509C), 0.19F

Update Interval

15 Seconds (7.5 sec for half an hour after a probe is connected)

Internal Temperature & Humidity Sensor

Type of Sensor

CMOSens® technology with digital interface

Temperature Accuracy

+0.5 °C (5 9C-40 °C), £0.9 °F Related to temperature of internal sensor

Humidity Accuracy

+2 %RH accuracy (10% - 90% range)

External Temperature Probe

Connector

SynolLog-HDR (Rear connector)
SynolLog-HDB (Bottom connector)

Type of Probe

SynoProbe Digital Interface Probe

Measurement Range

-40 °C - 130 °C (-40 °F - 266 °F)

Serial Numbers

Each probe has an unique internal serial number which is detected
and recorded by the SynolLog

More Details

Come in a range of lengths and in custom size: www.synotronics.com

Temperature Alarms

Visual Alarms

High and low set points trigger separate LED's

Audible Alarms

High and low set points trigger buzzer

Snooze Function

Buzzer can be snoozed for a preset amount of time after trigger

Memory

Recording Sampling Rate

0 - 800 minute Interval (1 minute steps)

Memory Type

Non-Volatile Eeprom

Data Capacity

> 16,000 Samples

Data Retention

> 100 Years Without Power

Other Specifications

Scheduled Record

Unit can be set to start recording at a pre specified start time and
stop at a pre specified end time

EMC

0 EMC Compliant : N15320

Disclaimer: The above specifications may be subject to change without notice.
The manufacturer and its suppliers hold no responsibility for damage expenses,
lost profits, or any other claims arising from the use of these products.




SYNOLOG-HD2x SPECIFICATIONS
2 Channel temperature and humidity logger with display

General Specifications

Dimensions

28mm x 66mm x 92mm  (1.1” x 2.6” x 3.65")

Power Source

3 x AAA, 1 Year Battery Life Replaceable

Operating Range

00C - 859C & 0-100%RH  (-30°C - 85°C with AAA Lithium)

Download Cable

Syno232 Download Cable

PC Software

Designed to use with SynoLog Studio for downloading and analyzing
data.

Display
Size 46mm x 20mm (1.8” x 0.8")
Resolution 0.19C (0°C -850°C), 0.1°F

Update Interval

15 Seconds (7.5 sec for half an hour after a probe is connected)

Internal Temperature & Humidity Sensor

Type of Sensor

CMOSens® technology with digital interface

Temperature Accuracy

+0.5 °C (5 9C-40 ©°C), £0.9 °F Related to temperature of internal sensor

Humidity Accuracy

+2 %RH accuracy (10% - 90% range)

Temperature Alarms

Visual Alarms

High and low set points trigger separate LED's

Audible Alarms

High and low set points trigger buzzer

Snooze Function

Buzzer can be snoozed for a preset amount of time after trigger

Memory

Recording Sampling Rate

0 - 800 minute Interval (1 minute steps)

Memory Type

Non-Volatile Eeprom

Data Capacity

> 16,000 Samples

Data Retention

> 100 Years Without Power

Other Specifications

Scheduled Record

Unit can be set to start recording at a pre specified start time and
stop at a pre specified end time

EMC

Q EMC Compliant : N15320

Disclaimer: The above specifications may be subject to change without notice.
The manufacturer and its suppliers hold no responsibility for damage expenses,
lost profits, or any other claims arising from the use of these products.
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SUPPPORT & SERVICE

Synotronics Pty Ltd

.
SYNOTRONICS
/

http://www.synotronics.com.au
technical@synotronics.com.au

Phone: +61 8 84314723
Fax: +61 8 84314736

23 Bishop Street
Skye, 5072
South Australia




